 TECHNICAL REFERENCE GUIDE

GroupWise  →  Google G Suite (Apps/Gmail)

Copyright by Transend Corporation
EXECUTIVE SUMMARY

This White Paper provides detailed information about migrating multiple user mailboxes from GroupWise to Google G Suite (Apps/Gmail).

It contains recommendations about preparing the Source and Target message platforms/servers to ensure the proper permissions are in place, and thus eliminating the reliance on individual user passwords.

It also provides in-depth information about specific features that alter the default behavior of Transend Migrator, and identifies best practices that enhance migration efficiency.

Step-by-step instructions detail how to configure the tool and perform the migration from beginning to end.

Need more help?

If you can’t find the information you seek, please view the Help File, which contains the most detailed information about every feature within the tool, including additional best practices.

Please also contact us directly to get answers to your questions, as well as inform us of what’s missing in this White Paper – we’re always looking for ways to improve our offering, and documentation is an important piece of the puzzle.
# Table of Contents

Section 1: Introduction .................................................................................................................. 1

Section 2: User Interface Overview .............................................................................................. 1

Section 3: Preparation of Source and Target Environments .......................................................... 3
  Preparing GroupWise for Migration .............................................................................................. 3
    Trusted Mode for GroupWise 2012 .......................................................................................... 3
    Trusted Mode for GroupWise 6.5 through version 8 ............................................................... 4
  Proxy Mode .................................................................................................................................. 5
  Preparing Google G Suite (Apps) for Migration .......................................................................... 6
  Administrative Service Account: OAUTH 2.0 ............................................................................. 6
  Transend Migrator Service Account ............................................................................................ 6
  Google Single User ....................................................................................................................... 7
  Google Archive ............................................................................................................................ 8

Section 4: Batch Migration Setup .................................................................................................. 10
  Assigning Batch Variables .......................................................................................................... 10
  Loading User Mailbox Account Data ........................................................................................ 11
  Validate Batch Setup .................................................................................................................. 12
  Migrated Checkboxes ................................................................................................................ 13
  Enable Migration ........................................................................................................................ 14
  Copy Configuration .................................................................................................................... 14

Section 5: Folders ........................................................................................................................ 15
  Folder Convert List ...................................................................................................................... 15
  Folder Exclude List ..................................................................................................................... 16
  Folder Mapping .......................................................................................................................... 17

Section 6: Address Translation ...................................................................................................... 18

Section 7: Migrating Messages/Folders (Step-by-step) ................................................................. 19
  GroupWise Considerations ........................................................................................................ 19

Section 8: Migrating Address Books (Step-by-step) ..................................................................... 20

Section 9: Migrating Calendar Entries (Step-by-step) .................................................................. 21

Section 10: Migrating Tasks & To-do Items (Step-by-Step) .......................................................... 22

Section 11: Custom Options ......................................................................................................... 23
  Commonly Used Custom Options ............................................................................................. 23
  Message Deduping ..................................................................................................................... 25
  Deduping in Batch Mode using a Variable ............................................................................... 26

Section 12: Command Line Processing ......................................................................................... 27

Section 13: Migration Monitor ...................................................................................................... 28

Section 14: Concurrent Migrations ............................................................................................... 29
  Performance ............................................................................................................................... 29
  Adding Migration Workstations ............................................................................................... 29
  Calculating Migration Time ...................................................................................................... 29

Section 15: Schedule Migration .................................................................................................... 30

Section 16: Reporting / Logging .................................................................................................. 31
  Reporting ................................................................................................................................. 31
  Logging ..................................................................................................................................... 32

Section 17: Troubleshooting ........................................................................................................ 33

Section 18: Technical Support ...................................................................................................... 35
**Section 1: Introduction**

This *Technical Reference Guide* details how to perform a batch migration of the following data types using Transend Migrator:

- Email Messages/Folders
- Address Books
- Calendar Entries
- Tasks/To Do Items

For more detailed information about your specific application, security requirements, and additional migration options, please review the *Help File*. The Transend Migrator Help File is context sensitive. Selecting a help button will take you to the specific section in the Help File related to the screen you are in.

**Section 2: User Interface Overview**

Transend Migrator contains an easy to use interface, designed to simplify the migration experience while allowing for maximum flexibility. Setting up your project to convert E-mail, Address Books, Calendars, and Tasks is accomplished within one user interface allowing you to quickly complete your migration in one run.

**Menu Bar**

The Menu Bar is where you will make your data type selections. The top level Menu is where you will find additional commands for saving configurations, setting various migration options, setting and viewing logging and reporting options, and setting up batch migrations for multiple users.
User Interface

The same interface is used whether you are migrating a single user mailbox or multiple user mailboxes at once (Batch Mode). Each screen for E-mail, Address Book, Calendar, or Task/To Do items is similar. Differences relate to the specific item types. The Email Configuration screen is shown below.

1. The Top Level Menu is where you set Migration Options, review log files, configure batch migration data and enter your license information.

2. The Buttons represent each data type available for migration: E-mail, Address Book, Calendar, and Task/To Do. You can migrate one or more data types at a time. Each data type needs to be configured individually and enabled individually. A green checkmark will appear on the button when it is enabled for migration.

3. The Source drop-down menu displays a list of all the available messaging systems you can migrate from.

4. After the Source system is chosen, data entry text boxes will display. Fill out the information required for your source system.

5. The Folders button allows you to specifically choose or exclude individual email folders. By default, all folders will migrate. Therefore, you do not have to configure the source Folders list. This is optional.

6. The Copy Configuration button allows you to copy configuration information from the first screen into all other data type configuration screens. By default, Transend Migrator will fill in the information it can for you. Once you make changes, then this button allows you to update the other data type screens with those changes. Only similar or like-fields will be updated. When you use the Copy Configuration button, you must re-enable the other data types for migration.

7. The Target drop-down menu displays a list of all the available systems you can migrate into.

8. After the Target system is chosen, data entry text boxes will display. Fill out the information required for your target system.

9. Enable the migration after you have configured both the source and target system by checking the Enable Migration checkbox. Once a data type is enabled a green checkmark will appear on that section’s button. Only the Enabled data types will migrate.

10. Select the Start Batch Migration button when you are ready to proceed with the migration.
Section 3: Preparation of Source and Target Environments

Ensuring that you are properly prepared for migration is essential to a successful migration experience.

Preparing GroupWise for Migration

Normally, you will use a logon and password in order to connect to the GroupWise email server. If you are migrating multiple GroupWise accounts you may use Trusted or Proxy mode.

**Trusted Mode** allows you to perform migrations for users without having to know each user’s password. You must have admin permission on the GroupWise server in order to use Trusted Mode. A user ID is still required, and you must be running GroupWise 6.5 or greater for this ability to be used.

**Proxy Mode** does not require admin permission. Instead, the alternate user account you will be migrating must give you proxy access to their data.

Trusted Mode for GroupWise 2012

You can create a Trusted Application key in Novell ConsoleOne, and enable Transend Migrator to use this key so that it can access user accounts without the need for a password. The following steps outline how to create a Trusted Application Key using Novell ConsoleOne.

**Note**
Your workstation must have the Novell Client installed, and you must be logged in as an Admin having permission to run the trusted application.

1. Start Novell ConsoleOne
2. Select *Tools* form the menu
3. Select the *GroupWise System Operations* submenu
4. Choose the Trusted Applications program.
5. Press the *Create* button.
6. Enter the Trusted Application name. If you are running Transend Migrator on multiple workstations, create a different key with a different name for each workstation.
7. Enter the location for the key file.
8. Enter the name of the key file. For Transend Migrator to recognize the key, it must be named *gwappkey.dat*.
9. Press OK to create the key.
After the key file is created, it must be edited so that it is recognized by Transend Migrator.

1. Open the gwappkey.dat file with Notepad or a text editor. Notice, the unique key will be the only entry in the file.

2. Add the name of the Trusted Application to the first line. In the above example, the Trusted Application is called Transend Migrator.
3. Enter a carriage return / line feed after the unique key.
4. Save the modified gwappkey.dat file.
5. Copy the gwappkey.dat file into the same directory where Transend Migrator is installed. By default, this directory is C:\Program Files\Transend Migrator\tmship on 32bit Windows systems, or C:\Program Files (x86)\Transend Migrator\tmship for 64bit Windows systems.
6. At this point you can run Transend Migrator as a Trusted application; however, you must tell Transend Migrator that it is in Trusted mode by using the /trusted switch (when using the GroupWise Client) or the /gwtrusted switch when connecting to GroupWise using the IMAP protocol.

**Trusted Mode for GroupWise 6.5 through version 8**

Perform the following steps to configure Transend Migrator as a Trusted application.

**Note**
This procedure requires Netware Admin rights to the GroupWise email server, and the Trusted program must be run on a 32bit Windows system. Contact your Network Administrator if you need Trusted Access.

1. Download the Transend Trusted package from [www.transend.com](http://www.transend.com). This package contains two files, gwtrustd.exe and gwtapp.dll.
2. Place gwtrustd.exe in the same directory as Transend Migrator.
3. Place gwtapp.dll into C:\Windows\System32.
4. Log into the Novell Network as administrator.
5. Map a drive to the location of where the GroupWise domain and post office can be found. The Trusted application requires a mapped drive and it needs to know where the domain files are located.
6. Open a Command Prompt, and change directories so that the current directory is the Transend Migrator installation directory.
7. Run gwtrustd.exe. This utility will ask you for the path to the GroupWise domain directory. This is the directory in which you can find the files GWDOM.DC and GWPO.DC. The utility optionally allows you to enter an IP address.
8. Enter optional settings or hit enter to complete the Trusted installation.

9. When it completes successfully, the effect of running this utility is to set Transend Migrator as a Trusted application. It creates inside the Transend Migrator installation directory the file “gwappkey.dat”, which contains the key information that Transend Migrator uses to enable Trusted mode.

10. At this point you can run Transend Migrator as a Trusted application; however, you must tell Transend Migrator that it is in Trusted mode by using the /trusted switch (when using the GroupWise Client) or the /gwtrusted switch when connecting to GroupWise using the IMAP protocol. See GroupWise Options for more details on the use of this switch.

Example

.Proxy Mode

Trusted Mode is the recommended method for converting user accounts using the Admin’s credentials. If Trusted Mode is not available you can then use Proxy Mode. GroupWise has a feature allowing one user to open email for another user. This is called Proxy Access and more information can be found on Proxy Access in the GroupWise documentation. Proxy access allows User A to grant access rights to User B, so that User B may read or create email for User A.

If proxy access has been given to the Admin performing the email migration then the Admin account will be able to convert email for users without knowing their password. It is recommended that you use Trusted Mode (see above), but if you are using a version of GroupWise older than 6.5 then Trusted Access mode is not an option. In that case, use Proxy Access or provide the user password.

In Transend Migrator, to perform a proxy login, modify the syntax of the “GroupWise User” field. Instead of using a single User ID, enter “UserB for UserA”, where UserB is the person who has been granted proxy rights, and “UserA” is the person who owns the mailbox. The password required will be that of UserB. In batch mode, this syntax is used for the “FromDatabase” field.
Regular Access

If you cannot use Trusted Mode or if Proxy Access is not an option then you need to provide the username and password for each GroupWise account.

Preparing Google G Suite (Apps) for Migration

When migrating to Google Apps or Gmail, you can specify either Google Single User, Google Apps (service account), Gmail IMAP (service account) or Gmail IMAP (single user). Google Archive can be used as a source only from Gmail. Under either Single User mode, you must provide a password for that user. Under both Google (service account) options, you must create a service account in the Google Developer’s Console and Authorize the service account as the administrator of the Google Apps domain in Google Admin Console. Under this option, you can migrate all of your users without needing the password for each Google user account.

Administrative Service Account: OAUTH 2.0

This option implements OAuth 2.0 with the service account option. Once OAuth 1.0 is no longer supported, this will be the only method of doing a migration using administrator credentials. You will grant permission to a service account to access your Google Apps data. In most cases this will be a service account created by you.

For information on how to set up a Google Service Account, view the Creating a Google Service Account white paper.

Transend Migrator Service Account

Transend has set up an existing service account that will be used by default; however, this opens up a security hole, since anybody who has Transend Migrator will be able to access your data during the period that access has been granted to that account. When you run Transend Migrator, this option will prompt you to supply your service account email, and a pathname of the private key file. Both of these fields may be left blank, in which case Transend’s service account is assumed.

Note: you still have to grant access to Transend’s service account (email: 24974064516@developer.gserviceaccount.com), and as previously noted, this opens up your data to anybody with Transend Migrator so it is recommended to setup your own service account with administrative rights.

For information on how to grant access to Transend’s Service Account, view the Granting Access to the Transend Service Account white paper.
To use Google Apps API, configure Transend Migrator as shown with *Google Apps (service account)*

Enabled the following custom option:

*Migration Options>Custom Options>Gmail/Google Apps>Authorization Service Account*

You can remove the Optional Service Account Email and Optional Private Key File fields since this authorization is now enabled in this custom option.

1. Enter the Google Email Address for the user.
2. Click Test Login and confirm that you are able to connect to Google after making these updates.
3. Click File>Save Configuration

**Google Single User**

If you have selected *Google Single User* as your source or target system, the first time you perform a migration, you will be shown a browser window that will allow you to log on to Google. Google will then ask you for permission to allow Transend Migrator to access your data. Press the Accept button, and the migration will proceed. The next time you try to migrate the same Google user, no browser window will be needed, because the authorization key is stored in the registry on your computer. If you try to migrate a different user, then the same process will be repeated.

1. Enter the Google Email Address for the user.
2. Click Test Login and confirm that you are able to connect to Google after making these updates.
3. Click File>Save Configuration
Click **ACCEPT** to allow Transend Migrator access to the single user data using the user’s login and password to Google.

Google Archive

Google allows its users to create an archive of various types of data, including email, calendar, and contacts, among other types (as of this writing, tasks are not supported). An archive consists of a zip file containing files in industry standard formats, such as mbox, .ics, and .vcf. Google Archive is a source option not a target migration option in Transend Migrator.

Transend Migrator works directly with the zip file, saving you the steps of unpacking the file and figuring out where to store the data, and how to tell Transend Migrator where and what the data is. With this option, you can select "Google Archive" as the convert-from choice and have it all done automatically. Using a Google Archive, versus direct access, also has the advantage of allowing Google to compress the data on its servers before being downloaded. In contrast, if you access email, for example, via IMAP, the data is not compressed during transfer, and thus the conversion will be slower. In addition, no throttling (deliberate slowing) is done during a zip file download.
For information on how to create a Google Archive, view the [Creating a Google Archive](#) white paper.

1. Once you have created and downloaded your archive .zip file, you may select "Google Archive" from Transend Migrator's email, calendar, or address book menus. Specify the name and location of the .zip file. For mail, you may select which folders to convert. For calendar and contacts, you may specify which calendar or address book to convert, or accept the default option.

2. Click **Browse** to locate the downloaded Google Archive zip file.

3. Click the **Copy Configuration** button and enable for Email, Address Book and Calendar.

4. Click **File>Save Configuration**.
Section 4: Batch Migration Setup

Setting up a batch process is nearly as easy as setting up a migration for a single user account. All batch data is stored in a Transend Migrator Data (TMD) file which contains all of the settings and options you have configured within the user interface. Select File | Save Configuration under the main menu to save all the current configurations to the default.tmd or custom TMD file.

Before configuring and processing a batch migration, we recommend you first test the conversion of one user mailbox to become familiar with how Transend Migrator operates.

Assigning Batch Variables

Once you have configured and tested a single user mailbox migration, you are now ready to turn your project into a batch migration by assigning variables to values that can change (usually the mail database or source user name, password, and target accounts). You assign these variables to values by populating the Batch Mode Data table.

The Batch Mode Data table is located at Batch Migration | Batch Migration Setup from the main menu. To perform a batch migration, the Batch Mode Data table needs to be populated with all the users’ account information required for the migration. You provide this information by entering it into each row and column cell, or by importing a comma delimited text file you have already created. The information required will vary depending on the email system you use.

Notice in the example, each column is associated with a variable, and those variables are $var1 through $var8. The user data is populated into the table, and one row represents one user’s data, and those are the values for the variables. Once all the data is entered, select the OK button to return back to the main interface and the data type you are working on (E-Mail, Address Book, Calendar or Task/To Do). Next, substitute the user account information with the variables found on each column header.

Note

The checkboxes are in read-only mode; however, you may right-click on the checkbox and select the appropriate option. You may also move your cursor to the checkbox field and press the space bar to set or clear the checkbox.
Loading User Mailbox Account Data

Load From File: The Load From File button allows you to load a text file, which is a comma separated value file, of the values you want to fill into the variables columns. In your migration, collect user data into a database or spreadsheet and then organize the user data by columns and rows. Extract the data into multiple comma separated value files (CSV) and import those CSV files by batches.

The following CSV file uses the semi-colon as a delimiter instead of the comma. This is useful to use when a value has a comma, and when the comma cannot be used.

Transend also supports uploading from an Excel Spreadsheet saved as a MS-DOS CSV file.

Load From Directory: The Load Column From Directory button allows you to load file or directory information into the column of your choice. This feature is helpful when you have migrations based upon files or directories rather than from direct connections, such as with Exchange/Outlook, Lotus Notes, and Novell GroupWise.
Compare the following two screenshots to see how the variables can be used. The first screenshot shows the configuration of a single-user email migration. The second screenshot shows how variables can be inserted into the configuration screen to turn a single-user migration into a batch migration.

**Single User Migration**

**Batch Migration (with Variables)**

The objective is to look for user data that will remain constant, and user data that needs to change.

Review your data as it is entered in the **Batch Mode Data** table, and then substitute what needs to change with the appropriate variable (e.g. $var1, $var2, etc.).

**Validate Batch Setup**

Use this feature to test your batch settings before beginning your batch migration. This feature will test the logon for each section you specify, and for each user listed in the **Batch Mode Data** table.

**Batch Migration Setup Test**

1. Select the source and target types you want to test the logon for.
2. Press the **Start Test** button.
3. Review your results.
Batch Migration Setup Report

Review the Batch Migration Setup Report results. If there are any connection failures, press the View Log button to review the log file generated during the test.

1. Press the View Report button to view test results. The report is created in XML, and viewable with Microsoft Excel. It will list each data type tested (email, address book, calendar, and task), and will report the success or failure of the source and target connection test.

2. Press the View Log button to view the master log file generated during the test. The log file is the master log file, and it will show the results of your validation test. Review this log file if you have a connection test failure, and look at the end of the log file for your latest test. Failures are recorded in red.

Migrated Checkboxes

The first column in each row has a checkbox that tracks which accounts have been successfully migrated thus far. If the box is checked it means that user has successfully migrated. You can then restart your migration and only migrate users who do not have a checkmark in the Migrated column.

After a migration is run, all users who were successfully migrated will have their Migrated checkbox checked. This checkbox information is stored along with the other migration data within the TMD file. Therefore, it is very important to save the TMD file before and after a migration. When you exit Transend Migrator after a migration you will receive a warning if you have updated checkboxes and are attempting to exit without saving.

When you run the same migration again by pressing the Start Batch Migration button, Transend Migrator will give you the option of converting just the unchecked entries, or to convert them all.

Right click to see the options: View log for record 1, Change Migrated State, Set All Rows to Migrated or Set All Rows to Not Migrated
Enable Migration

When you are finished inserting the different variables in the appropriate locations, enable the migration by checking the *Enable Migration* Checkbox. Notice, the green checkmark will appear on the appropriate tab after fully configuring and enabling a migration section.

Copy Configuration

If your migration will include Address Books, Calendars, or Task/To Do items, and those data types will use the same account information as Email, select the *Copy Configuration* button to copy your changes to the other data type sections.

*Helpful Hint*

It is possible you will want to migrate data that is in a different format as the email system data you are migrating. For example, you could be migrating email from an IMAP system, but your Address Books are LDIF files and your Calendar items are VCS files. Transend Migrator is very flexible and configurable to your unique environment. However, in this situation you would NOT want to use the *Copy Configuration* button.
Section 5: Folders

By default, all available folders will migrate during email conversion. You can change this behavior by selecting the specific folders you want to migrate or selecting specific folders you want to exclude.

Folder Convert List

The Folder Convert List is blank by default. When the list is blank this means that all folders available in the source account will migrate. You may want to press the Load from E-Mail Source button to review the available folders so that you can manually choose which folders to migrate. Remove a checkmark if you do not want a specific folder to migrate.

You may also want to load the list of folders into the Folder Convert List so that you can create a list of folders you do not want to migrate. For example, maybe you do not want to migrate the Junk Mail folder for one account, or for all accounts. Right click on the folder you do not want to migrate, add it to the Folder Exclude List, and then press the Clear Data button to remove all entries from the Folder Convert List. When the Folder Convert List is empty, this tells Transend Migrator to convert all folders except what is listed in the Folder Exclude List.
Folder Exclude List

You may want to exclude certain folders from being migrated. Select a specific folder you wish to exclude, right-click, and then choose the To Exclude List option to copy the folder name to the Exclude List. This is commonly used in Batch Mode so that a specific folder will be excluded for all accounts. This is helpful for when you want to migrate all available folders except for a select list. After adding folders to the Folder Exclude List, remember to clear the list of folders in the Folder Convert List.

1. Enter the names of the folders you wish to exclude.
2. Optionally, if you have a text file containing folder names to exclude you may load that list by pressing the Load From File button.
3. Right Click in this window for other options on these entries. These Unicode features are helpful when migrating non-English character sets.
   OR
4. Click Migration Options>Email Convert List
5. Click Load from Source
6. Right click and select the folder and select Add to Folder Exclude List
7. Use the wildcard * to include subfolders
Folder Mapping

Folder Mapping allows you to migrate a folder with a certain name into another folder with a different name. In many email systems, folders have similar functions yet they have different names. For example, new messages received into Lotus Notes are placed inside the Notes Inbox folder. In Microsoft Exchange, new messages received are placed inside the Inbox folder. If you want the Notes Inbox items migrated from the Lotus Notes Inbox into the Microsoft Exchange Inbox then create a Folder Map.

You may also map to a new folder on the target email system. Enter the new name into the New Folder Name field and messages specified within the Original Folder Name field will migrate into that folder.

Enter the folder names by putting your cursor into the text box and then begin typing.

Press the Tab key to get to the next textbox on the list.

Press Shift-Tab to go to the previous textbox on the list.

**Suggestion**

An easy way to load the Original Folder Name is to load the folder list on the Folder Convert List tab, right click on the folder to be mapped, and then choose the Add to Folder Map menu option. This feature will copy the folder name into the Original Folder Name textbox on the Folder Mapping tab.

Because the folder names must be exact, adding the Original Folder Name from the Folder Convert List will ensure it is entered in correctly.

**Load From File**

You may also create a comma separated value (CSV) file containing a list of Original Folder Names and the New Folder Name. Save this file as a text file. Load the text file into the Folder Mapping table and the entries will fill into the Original Folder Name and New Folder Name fields.

**Example Map File**

The CSV file is a text file with these two values. Each line contains the exact name of the Original and Target folder name separated by a comma.

**Note**

If you do not want to map any folders but want to place all folders into a Group Folder, use the Group Folder switch found in Migration Options | Custom Options. The switch is /GN <value> where value is the name of the group folder.
Section 6: Address Translation

Transend Migrator supports address translation through the *Address Translation Table*. You can access the *Translation Table* under *Batch Migration* → *Batch Migration Setup* → *Address Translation* from the main menu.

The *Translation Table* allows you to create Internet Style addresses based upon the criteria you provide. The *Translation Table* is helpful to use if you are changing the email address of your users and if you want Transend Migrator to make those changes during the migration. It is also helpful to use when migrating distribution lists and calendar attendees.

Transend Migrator expects to find a match within the *Address Translation Table*. Changes will only be made to matches found.

The *Address Translation Table* is divided into two sections. The first section is the *Old Address* format, and the second section is the *New Address format* you want it to be. The Old Address section of the Address Translation Table must be in the exact format the source application stores it.

**Translation Table Example**

Enter the Address Translation Table data into the fields provided on the *Address Translation* tab. You may also import your csv text file containing address translation data into the Address Translation interface.

![Address Translation Table Example](image)

For more detail about *Address Translation* refer to the Transend Migrator help file.
Section 7: Migrating Messages/Folders (Step-by-step)

The following is a step-by-step guide of how to migrate *E-Mail* from GroupWise to Google Apps/Gmail:

1. Select the *Email* button to configure the email choices.
2. Select *GroupWise (via GW API)* or *GroupWise (via IMAP)* from the *From* drop down box on the Source Pane (left side of the screen).
3. Enter the Server Name, User Name and Password (if necessary).
4. Select the *Folders* button to choose which folders to migrate. All folders will migrate by default if no folders are displayed in *Email Convert List*.
5. From the *To* drop down box in the *Target* pane (right side of the screen) select *Google Single User* or *Gmail IMAP (Single User)* for single user migration. *Or use Gmail IMAP (service account)* or *Google Apps (service account)* to migrate multiple users in batch mode.
6. Enter the Server Name, Google Email Address, Optional Service Account and Optional Service Account Private Key file.
7. Insert the different *batch variables* in the appropriate source and target locations (if necessary).
8. Place a checkmark in the *Enable Migration* Checkbox to enable Email for migration.
9. Optionally, configure and enable the other migration choices (Address Book, Calendar, and Task) if they are to be included with this migration.
10. Select the *Start Batch Migration* button to complete the migration. The *Migration Monitor* will start and display the real-time migration progress.
11. Once complete, select the *OK* button to go back to the main screen.

All options implement the OAuth 2.0 protocol. The only difference is that Transend Migrator will connect to Google IMAP servers instead of using servers that support the Google http API. We have found that usually the IMAP service is faster, however it may be subject to throttling, i.e. a deliberate slow down by Google.

GroupWise Considerations

There are two primary methods you can use when migrating email from GroupWise. The first method is via the GroupWise Object API, which requires the GroupWise email client be installed. It contains a set of Dynamic Link Libraries (DLL), or application files that are included with the Novell GroupWise Client software.

The second method is via the IMAP4 protocol. Rather than migrating from or to GroupWise using the GroupWise API, enable IMAP4 support and migrate from or to GroupWise using the *GroupWise (via IMAP)* choice. This choice is often more reliable and faster than using the GroupWise API method, and is the preferred choice when migrating only email between GroupWise and Microsoft Exchange/Outlook (2003, 2007, 2010) via MAPI.

**Requirements.** The GroupWise client software is required when using the GroupWise API, and it is also required if you are migrating GroupWise archives. For live email, the IMAP4 protocol must be enabled on the GroupWise server if using the IMAP4 method. Lastly, an active or live GroupWise email account must exist. The logon and password is required. Optionally, you can migrate another account if you have proxy access to that account or by using Trusted Mode.
Important Information

Ensure you are running a stable release of GroupWise, and use the recommended patches or updates required by Novell. If you are running GroupWise versions 6 then patch to version 6.5.7. If you are running version 7 then patch to 7.0.3 or greater. Similarly, if you are running GroupWise version 8 then patch to version 8.0.1 or greater.

GroupWise 5.x. If you are migrating from GroupWise 5.x and if you are using the GroupWise API method, then you may need to use the /GW5 switch option so that you can connect to it. This is an undocumented switch so enter this switch into the Undocumented Options section of Transend Migrator, which is found in Migration Options | Custom Options | Other | Undocumented Switches.

Warning

When migrating messages using the GroupWise API method, migrate a test account before migrating a live account. For some reason, some older versions of GroupWise will change the date of the source messages to the current date and time. This rarely happens, but if it does happen the message date issue is irreversible, and we recommend migrating live messages using the IMAP4 protocol instead.

Data File. The GroupWise data is stored within a GroupWise email server. Therefore, the GroupWise server must be running. Because GroupWise email data is located on a live GroupWise server there aren’t any source files; however, GroupWise archives can be stored on a local workstation or on a network share. Transend Migrator can convert from the archives. The GroupWise API is required in order to migrate GroupWise archives unless the archives are un-archived back into the live account. In that case, you will also be able to migrate via the IMAP4 protocol.

Section 8: Migrating Address Books (Step-by-step)

Transend Migrator can read address information directly from a GroupWise 5.5+ address book. You must be running Transend Migrator on a PC that has the GroupWise client installed. (Note: 5.5 or greater is required). If you have an earlier version of GroupWise, please use the Novell NAB format instead.

If there are connection problems when migrating from or to a Novell GroupWise address book, verify the account connection by opening the GroupWise account with the GroupWise client software. Then, open up the address books and note the name of the personal address book. Some versions of GroupWise name the address book "Personal Address Book" while some installations name the address book with the username. When migrating from GroupWise address books, use the asterisk * to tell Transend Migrator to migrate all personal address books.

- Requires. The GroupWise client software is required and a live connection to a GroupWise server is required. Ensure you are running a stable release of GroupWise, and use the recommended patches or updates required by Novell. If you are running GroupWise versions 6 then patch to version 6.5.7. If you are running version 7 then patch your version to 7.0.3 or greater. Similarly, if you are running GroupWise version 8 then patch to version 8.0.1 or greater.
• **Data File.** The GroupWise address books are located inside the GroupWise account. A MAPI connection is required. Address books must be specified by name, or an asterisk can be specified to migrate all user address books to a different system.

The following is a step-by-step guide of how to migrate *Address Books* from GroupWise to Google Apps/Gmail:

1. Select the *Address Book* Button to configure the Address Book choices.
2. Select *GroupWise* from the *From* drop down box on the *Source* pane (left side of the screen).
3. Enter the address book name. **Use an asterisk * to migrate all address books.**
4. Enter the User Name and Password (if necessary).
5. From the *To* drop down box in the *Target* pane (right side of the screen) select *Google Single User, Gmail IMAP (Single User)* for single user migration. Or use *Gmail IMAP (service account)* or *Google Apps (service account)* to migrate multiple users in batch mode.
6. Enter the Server Name, Google Email Address, Optional Service Account and Optional Service Account Private Key file.
7. Insert the different *batch variables* in the appropriate source and target locations (if necessary).
8. Place a checkmark in the *Enable Migration* Checkbox to enable Address Book for migration.
9. Optionally, configure and enable the other migration choices (Email, Calendar, and Task) if they are to be included with this migration.
10. Select the *Start Batch Migration* button to complete the migration. The *Migration Monitor* will start and display the real-time migration progress.
11. Once complete, select the OK button to go back to the main screen.

### Section 9: Migrating Calendar Entries (Step-by-step)

**Requires.** The GroupWise client software is required and a live connection to a GroupWise server is required. Ensure you are running a stable release of GroupWise, and use the recommended patches or updates required by Novell. If you are running GroupWise versions 6 then patch to version 6.5.7. If you are running version 7 then patch your version to 7.0.3 or greater. Similarly, if you are running GroupWise version 8 then patch to version 8.0.1 or greater.

**Data File.** The GroupWise calendars are located inside the active GroupWise account. Transend Migrator uses MAPI to connect to GroupWise. Therefore, no local files are involved with the migration. You will need the logon credentials for the GroupWise user being migrated.

The following is a step-by-step guide of how to migrate *Calendar Entries* from GroupWise to Google Apps/Gmail:

1. Select the *Calendar* button to configure the calendar choices.
2. Select *GroupWise* from the *From* drop down box on the *Source* pane (left side of the screen).
3. Enter the User Name and Password (if necessary).
4. Optionally, check the *Upcoming events only* checkbox to convert future items. Enabling this checkbox migrates only items originally created for future dates.
5. From the To drop down box in the Target pane (right side of the screen) select Google Single User, Gmail IMAP (Single User) for single user migration. Or select Gmail IMAP (service account) or Google Apps (service account) to migrate multiple users in batch mode.

6. Enter the Server Name, Google Email Address, Optional Service Account and Optional Service Account Private Key file.

7. Insert the different batch variables in the appropriate source and target locations (if necessary).

8. Place a checkmark in the Enable Migration Checkbox to enable Address Book for migration.

9. Optionally, configure and enable the other migration choices (Email, Calendar, and Task) if they are to be included with this migration.

10. Select the Start Batch Migration button to complete the migration. The Migration Monitor will start and display the real-time migration progress.

11. Once complete, select the OK button to go back to the main screen.

---

**Section 10: Migrating Tasks & To-do Items (Step-by-Step)**

**Requires.** The GroupWise client software is required and a live connection to a GroupWise server is required. Ensure you are running a stable release of GroupWise, and use the recommended patches or updates required by Novell. If you are running GroupWise versions 6 then patch to version 6.5.7. If you are running version 7 then patch your version to 7.0.3 or greater. Similarly, if you are running GroupWise version 8 then patch to version 8.0.1 or greater.

**Data File.** The GroupWise Tasks are located inside the active GroupWise account. Transend Migrator uses MAPI to connect to GroupWise. Therefore, no local files are involved with the migration. You will need the logon credentials for the GroupWise user being migrated.

The following is a step-by-step guide of how to migrate Task/To Do Items from GroupWise to Google Apps/Gmail:

1. Select the Task/To Do button to configure the task choices.

2. Select GroupWise from the From drop down box in the Source pane (located on the left side of the screen), and then enter the required information for your task application.

3. From the To drop down box in the Target pane (right side of the screen) select Google Single User, Gmail IMAP (Single User) for single user migration. Or select Gmail IMAP (service account) or Google Apps (service account) to migrate multiple users in batch mode.

4. Enter the Server Name, Google Email Address, Optional Service Account and Optional Service Account Private Key file.

5. Insert the different batch variables in the appropriate source and target locations (if necessary).

6. Place a checkmark in the Enable Migration Checkbox to enable Address Book for migration.

7. Optionally, configure and enable the other migration choices (Email, Calendar, and Task) if they are to be included with this migration.

8. Select the Start Batch Migration button to complete the migration. The Migration Monitor will start and display the real-time migration progress.

9. Once complete, select the OK button to go back to the main screen.
Section 11: Custom Options

Custom Options are additional settings that allow you to alter the default behavior of Transend Migrator. All Custom Options are detailed in the Help File.

Select Migration Options | Custom Options from the main menu in order to configure available options.

Search Information

If you want to enable an option but do not know where to find it, enter a keyword inside the search text box to search for the option. Transend Migrator will search for that keyword inside the entire Custom Options section and display the results.

Select the Next button to review all the sections where your keyword was found. You may also search by a specific option switch (e.g. /D140). Sometimes an option can be found in two or more locations. Review the correct location for the option and then enable it in the source or target section related to your specific project.

Review enabled Options by selecting the View Enabled Options button on the Custom Options screen or by selecting Enabled Migration Options from the View menu. These choices will display all enabled options by category.

Commonly Used Custom Options

<table>
<thead>
<tr>
<th>Custom Option</th>
<th>Switch</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Installation</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proxy Server</td>
<td>/PROXY</td>
<td>For license key verification. Internet access is required. If your network uses a proxy server then you will need to use this switch.</td>
</tr>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date Range</td>
<td>/UADATE</td>
<td>Migrates email, calendars, and task items within a given date range.</td>
</tr>
<tr>
<td>Message Date Range</td>
<td>/MSGDATE</td>
<td>Migrates only messages within a given date range.</td>
</tr>
<tr>
<td>Calendar Date Range</td>
<td>/CALDATE</td>
<td>Migrates only calendars within a given date range.</td>
</tr>
<tr>
<td>Max Message Size</td>
<td>/MAXMSGSIZE</td>
<td>Set the Max Message Size as 25000 KB’s or 25 MB which is the Office 365 limit. If the sum of the attachments causes the entire message to exceed</td>
</tr>
<tr>
<td>Parameter</td>
<td>Command/Flag</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Max Attachment Size</td>
<td>/MAXATTACHSIZE</td>
<td>Any attachment with a size greater than this value will be removed and replaced with a text stub.</td>
</tr>
<tr>
<td>Detach Attachments</td>
<td>/DETACH</td>
<td>Use this switch when the Max Attachment Size switch is enabled. When the attachment exceeds the maximum attachment size, the attachment will be placed into the directory specified by the /DETACH switch. Create a directory on the migration workstation called c:\detach and apply a variable so each user has a directory for attachments, the parameter is specified as c:\detach$Var1</td>
</tr>
<tr>
<td>Recurring Calendar Entries</td>
<td>/D127</td>
<td>Recurring calendar entries will appear in the target as true recurring events, instead of separate individual events.</td>
</tr>
<tr>
<td>Recurring Calendar entries - Expand</td>
<td>/D179</td>
<td>Forces calendar entries to expand where supported.</td>
</tr>
<tr>
<td>Migrate Unique Messages</td>
<td>/DEDUP</td>
<td>Migrate unique messages and to record the MD5 hash value of the messages into a new or existing file.</td>
</tr>
<tr>
<td>Deduping File Writes</td>
<td>/D165</td>
<td>Write the MD5 hash values immediately to the dedup file after each message instead of writing to memory. This will affect the speed of the migration, but allows better recovery from a crash.</td>
</tr>
<tr>
<td>Deduping Criteria</td>
<td>/D56</td>
<td>Only used when the /DEDUP switch is enabled, and it overrides the default behavior. Choose which fields to run the MD5 Hash algorithm against.</td>
</tr>
<tr>
<td><strong>GroupWise Specific</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trusted Mode – MAPI</td>
<td>/TRUSTED</td>
<td>When Trusted Mode is enabled, this switch tells Transend Migrator to migrate GroupWise MAILBOXES without the need for each user password. This switch is used with the GroupWise API connection.</td>
</tr>
<tr>
<td>Trusted Mode – IMAP</td>
<td>/GWTRUSTED</td>
<td>When Trusted Mode is enabled, this switch tells Transend Migrator to migrate GroupWise MAILBOXES without the need for each user password. This switch is used with the GroupWise IMAP connection.</td>
</tr>
<tr>
<td><strong>Google Apps / Gmail</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Authorization – Service Account</td>
<td>/XOAUTHSA</td>
<td>Enable to migrate bulk users in batch mode without having to use each user password. For Google Service Account email, calendar, contacts, or tasks migrations, specify the service account email and path to P12 key in the form: service account email address</td>
</tr>
<tr>
<td>Attachment Rename - Google</td>
<td>/D189</td>
<td>Append “.dat” to file attachments containing “bad” extensions, such as .exe, to prevent Google from rejecting the message.</td>
</tr>
<tr>
<td><strong>Logging / Reporting</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Debug Logging</td>
<td>/DEBUG</td>
<td>Adds additional logging to the log file, which is helpful when troubleshooting. It attempts to log every single step of the migration which causes the log file to get quite large.</td>
</tr>
<tr>
<td>Log Subjects</td>
<td></td>
<td>Adds the Subject line information to the tmlog</td>
</tr>
<tr>
<td>Log Time Stamps</td>
<td></td>
<td>Add the timestamp to the tmlog</td>
</tr>
<tr>
<td>Migration Report Level</td>
<td>/XMLREPORTLEVEL</td>
<td>Use this switch and value to determine the level of detail recorded into the XML report.</td>
</tr>
<tr>
<td><strong>Throttling Options</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum Stall Seconds</td>
<td>/MAXSTALL</td>
<td>Sets the number of seconds the batch mode will allow a migration process to be idle for before failing the migration. Default is 180 seconds.</td>
</tr>
<tr>
<td>Reconnect</td>
<td>/D197</td>
<td>Allows Transend Migrator to reconnect to the server when the tcp/ip connection fails (the default is 3).</td>
</tr>
<tr>
<td>Timeout</td>
<td>/TO</td>
<td>Increase the Timeout when connecting to the IMAP server (default is 25 seconds).</td>
</tr>
</tbody>
</table>
Message Deduping

Transend Migrator has the ability to prevent duplicate message items from migrating. This feature is helpful in the event you want to restart a migration, or run a delta. It is also helpful when you restore many email archives from a particular person, and you want to output only the unique messages.

When deduping enabled, Transend Migrator performs a calculation called an MD5 hash on each message item to see if it is unique. It writes that the results of the MD5 hash into memory. At the end of your migration, the MD5 information is taken from memory and written to file.

The calculation is performed on the following metadata items to see if they are unique or different:

- Message Body
- Subject
- Date
- Sender
- Recipient List

These default metadata items can be changed, and you can also add additional requirements such as:

- Folder
- Attachment Header
- Attachment Data
- Unique ID

Enable Deduping:

1. Select Migration Options from the menu.
2. Select Custom Options from the sub menu.
3. Expand the General section to see the section choices.
4. Enable the section titled, “Migrate Unique Messages”.
5. Press OK to complete this custom option.

When no parameter is entered, Transend Migrator will first write the MD5 hash value of each message into memory, and then write that information into a file called md5.dat, and this file will be created inside the same directory as the master log file (tmlog.html).

Suggested Deduping Options

Sometimes, a migration will fail and end abnormally. When this happens, the MD5 information in memory does not get written to disk. Therefore, when this happens you will have some duplicate email items if you decide to migrate all message folders over again. Therefore, you can force Transend Migrator to write the MD5 information to disk immediately instead of waiting until the migration is complete.
Deduping in Batch Mode using a Variable

In batch mode, it is common practice to create an md5 hash file for each account migrated. In batch mode, variables are defined, such as $var1, for the name of the dedup file. Often, a variable is a user name so consider using the user name as the variable. It is easier to keep track of the file if it is related to the user name, and you will only have to use one variable.

1. Turn on deduping by enabling the Custom Option Setting called, “Migrate Unique Items.”

2. Add a path and filename to the Parameter. Use an existing file or create a new file. Use the same file if you plan on deduping between migrations.

3. Enable the /D165 switch, which is titled, Deduping File Writes. This switch forces Transend Migrator to write the MD5 hash value to disk immediately rather than after the migration is over.

4. Optionally, enable the /D56 switch and then modify the default value, which is BSDNR. Add at the F value if you want to include the message folder as part of your deduping criteria. This might not be a good idea if migrating from Lotus Notes and you are migrating views and folders. This might be a good idea if you are migrating from another program and you want duplicate items in different folders. Perhaps, the folder is important.

5. Deduping Criteria - Use these parameters in the Deduping Criteria switch to choose which fields to run the MD5 Hash algorithm against.

<table>
<thead>
<tr>
<th>F = Folder</th>
<th>B = Message Body</th>
<th>S = Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>D = Date</td>
<td>R = Recipient List</td>
<td>N = Sender</td>
</tr>
<tr>
<td>H = Attachment Header (name and length)</td>
<td>A = Attachment Data</td>
<td>U – Unique ID</td>
</tr>
</tbody>
</table>

Note
You cannot share the dedup file with another process. Therefore, create a unique dedup file for each account migrated.
Section 12: Command Line Processing

An alternate way of starting a batch migration is through the command line or with a batch file. Once all Email, or Address Book, or Calendar, or Tasks sections have been set you normally begin the migration by pressing the Start Single Migration or the Start Batch Migration button. You may also start a migration through a command line after saving your configuration using the File | Save Configuration As... menu choice.

1. Setup a migration project for one user or for a batch of accounts.
2. Load the user list if you are migrating in batch mode.
3. Save your configuration by selecting File | Save Configuration As... from the main Transend Migrator screen. Name the configuration file and keep it short. Once have saved your settings into a configuration file you can then run a batch migration from the command line. Review the Command Line Syntax & Example section for the command line detail.

Command Line Syntax & Example

Syntax: TM12.EXE /CMDL /F <path and filename>

Example: TM12.EXE /CMDL /F C:\ProgramData\Transend\Project.tmd

Additional Options

/CONCURRENT <n> Allows # of concurrent migrations to be set through the command line rather than using the Migration Monitor interface.

Note
The command line must be executed from the Transend Migrator installation directory. It will be easier to create a batch file using Notepad rather than manually running it from the command line. Below is an example of a simple batch file:
1. Start Transend Migrator and configure the settings for one or more accounts.
2. Save your configuration by selecting File | Save Configuration from the main Transend Migrator screen. For this example, save your configuration file into C:\Migrate\project.tmd
3. Create a batch file and use the Batch File Example as a guide.

Batch File Example

![Image of batch file example]

Run the Batch File

Double-click on the batch file using Windows Explorer. Once the batch file starts it will load the Migration Monitor and begin migration. When the migration completes the Migration Monitor will exit.

Provide accounts in CSV file

Normally, in a command line migration all your settings and account information is saved in the Transend Migrator configuration file (TMD); however, you may save the account information inside a CSV file and reference that CSV file. This is useful when you will be automating the user list extraction and do not have the ability to save the user information in the TMD file. The CSV file will contain the values for the variables you define in the TMD file. Use the /batchdata <file> switch in addition to your other command line switch choices. Any values declared in the TMD file will be replaced, and the values in the CSV file will be used.

Batch File Example with CSV file containing user information

```
Example  TM12.EXE /CMDL 1 /F C:\ProgramData\Transend\Project.tmd /batchdata C:\Migrate\Userlist.csv
```

Section 13: Migration Monitor

The Migration Monitor displays the real-time status of all user mailboxes as they are migrated. The Migration Monitor is a multi-threaded process, which means that multiple accounts can be migrated at the same time if the email systems support concurrent migrations, and if your license permits.
Section 14: Concurrent Migrations

Transend Migrator has the ability to migrate more than one account at a time, and this is called Concurrent Migrations. During a batch process, Transend Migrator will migrate each account in entry order, which is defined in the Batch Mode Data table. It starts at the top and works through the list until the list is complete. If your license allows, you may migrate more than one account at a time. This allows you to complete your project more quickly.

Adjust the number of concurrent migrations when you begin a migration and the Migration Monitor appears. Transend Migrator will default to 1 concurrent migration. Press the up or down arrow to adjust the number of concurrent migrations.

Performance

Increase the number of concurrent migrations to attain the best possible speed your system will allow. Each computer system is different, and each email system is different. Migrating data on a local machine gives you one rate of speed, while migrating across a local area network will give you a different rate of speed. The number of email messages and attachments will also affect your migration rate, as will the size of those messages and attachments.

The best way to determine how fast you can perform a migration is by setting up a few test accounts and giving each account 1 Gigabyte of normal email data. Migrate one account at a time and review the rate of speed. Then, migrate the same test accounts and increase the number of concurrent migrations to 2, and so on. Evaluate the rate of speed and the combined rate of speed. Lower the number of concurrent migrations when you see a decrease in migration rate.

Adding Migration Workstations

At some point, you will reach the maximum capability of your migration workstation, and you may want to add more workstations to decrease the amount of time it takes to migrate your accounts. Review how long it takes to migrate 1 GB of data on a single workstation, determine the number of concurrent migrations your workstation will allow, and then calculate how much faster your project will complete by adding workstations.

Calculating Migration Time

Below are examples of an easy way to calculate how long it will take to complete a migration. Create a simple spreadsheet that lists the total number of gigabytes to migrate, the quantity of workstations you will use, and then the rate of speed your system will migrate. Then, enter a simple formula to calculate how long your migration will complete with one workstation. In these screenshot examples, your formula would be: \( \frac{\text{Gigabytes/Rate}}{\text{PC’s}} \).
In Microsoft Excel, your formula would look similar to: \( \frac{E14}{E16}/E15 \)

**Spreadsheet Example 1**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>E14</td>
<td>Total Quantity of Data to Migrate in Gigabytes</td>
<td>350</td>
</tr>
<tr>
<td>E15</td>
<td>Quantity of PCs to Process the data</td>
<td>1</td>
</tr>
<tr>
<td>E16</td>
<td>Gigabytes per Hour</td>
<td>3</td>
</tr>
</tbody>
</table>

Processing Time For Completion in Hours: 31.67
Number of Days: 4.86

In the spreadsheet example above, it will take 4.86 days to migrate 350 gigabytes of data at the rate of 3 gigabytes per hour. Therefore, you may want to add more machines to complete your project in a shorter amount of time.

**Spreadsheet Example 2**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>E14</td>
<td>Total Quantity of Data to Migrate in Gigabytes</td>
<td>350</td>
</tr>
<tr>
<td>E15</td>
<td>Quantity of PCs to Process the data</td>
<td>5</td>
</tr>
<tr>
<td>E16</td>
<td>Gigabytes per Hour</td>
<td>3</td>
</tr>
</tbody>
</table>

Processing Time For Completion in Hours: 23.33
Number of Days: 0.87

If you are using a simple formula, add more workstations to your spreadsheet to determine how much faster your project will complete. In Spreadsheet Example 2, the same migration will complete in 23 hours if 5 workstations are used at the same time. Be careful when adding computers to your project, and verify your source/target servers and network can handle the workload. In you are migrating into Microsoft Exchange, we recommend you turn off *Transaction Logging* so that your Exchange Server will not become overloaded and use up too much disk space. Turn *Transaction Logging* back on when your migration project is complete.

### Section 15: Schedule Migration

You may schedule a migration to begin at a later time by setting the start time on the *Migration Schedule* screen. Start later in the evening when you can receive optimal performance, bandwidth, and no interruption. If there are other processes that must begin while the migration is running then you may also pause the migration, and continue after the processes are complete.

You must configure your migration before you can schedule it. Pre-configure the E-Mail, Address Book, Calendar, and Tasks as they need to be set. Import your list of users if performing a batch migration, and then save this configuration by selecting *File | Save Configuration* from the Transend Migrator main menu.

**Caution**

Once the schedule has been set it will become effective and begin only after pressing one of the Start Migration Buttons. Migration will not happen if you close Transend Migrator.

You do not have to set all options in the Migration Schedule. Only the values with an enabled checkbox will take effect after pressing the Start Migration Button.
Section 16: Reporting / Logging

Reporting

Migration reports in XML format will be created after each successful run, and can be viewed with Microsoft Excel. XML reports can be found inside the default subfolder or in a folder containing the name of the custom configuration, and can easily access by selecting View / Migration Reports from the main menu. Each time a migration is run a new Migration Report will be created, and it will be assigned an incremental number beginning with the number 1.

The default detail contained within the XML Report contains the following information:

- User ID
- Status
- Database / User
- Time Started
- Elapsed Time
- Folder Count
- Email Count
- Address Count
- Calendar Count
- Task Count
- Skipped Entries
- Data Rate (megabytes per hour)

Use the following switch and value to increase or decrease the level of detail in the XML Report:

<table>
<thead>
<tr>
<th>Switch</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/NOXMLREPORT</td>
<td></td>
<td>Use this switch to disable XML reporting. No XML report will be produced when this switch is used.</td>
</tr>
<tr>
<td>/XMLREPORTLEVEL &lt;n&gt;</td>
<td></td>
<td>Use this switch and value to determine the level of detail recorded into the XML report. The default value is 1. Increase the value to 2 if you want to record Folder Names and Entry Counts for those folders.</td>
</tr>
</tbody>
</table>

Note

Transend Migrator reports the number of attachments converted with each message; however please be aware that this number may include graphic images embedded within HTML documents. Therefore, the number of actual attachments visible in your email client, such as Word or Excel files, may be different than reported.
Logging

Transend Migrator will create a master log file named tmlog.html inside the default system directory. This log file contains detailed information about the migration session. User specific log files will be called Tmlog-#.html. The number # will correspond with the specific job number for that user as found in the Migration Monitor. This file contains detailed information about a specific user. Since the log files are HTML they are viewable by using your Internet browser. If you want text based log files then use the /LTEXT switch option located inside the Log File section in Custom Options.

You can find the log files inside one of the following system directories:

<table>
<thead>
<tr>
<th>Windows XP</th>
<th>C:\Documents and Settings\All Users\Application Data\Transend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista</td>
<td>C:\Documents and Settings\All Users\Application Data\Transend</td>
</tr>
<tr>
<td>Windows 7, 8</td>
<td>C:\ProgramData\Transend</td>
</tr>
<tr>
<td>Windows 2008 R2</td>
<td>C:\ProgramData\Transend</td>
</tr>
<tr>
<td>Windows 2012 R2</td>
<td>C:\ProgramData\Transend</td>
</tr>
</tbody>
</table>

Each time you migrate an account, Transend Migrator will create a user specific log file inside a subdirectory from one of the two system folders listed in the above table. This subdirectory will be called default, which is the same name as the default configuration TMD file containing all of the settings and options used in the user interface. If you create custom configuration files the subdirectory containing user log files will be given the custom configuration’s name rather than default.

The following switches are available to change the way Transend Migrator records information inside the user specific log files.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/LAP</td>
<td>This switch tells Transend Migrator to append to the existing log file instead of creating a new one on each run.</td>
</tr>
<tr>
<td>/LL</td>
<td>Use this to create a Summarylog.txt file.</td>
</tr>
<tr>
<td>/LNO</td>
<td>Use this switch to disable logging. Creating a log is enabled by default.</td>
</tr>
<tr>
<td>/LSUB</td>
<td>If enabled, each message converted will have its subject added to the log file.</td>
</tr>
<tr>
<td>/LTEXT</td>
<td>Use this switch to create text log files instead of HTML log files.</td>
</tr>
<tr>
<td>/LTS</td>
<td>Adds a timestamp value to each line in the log file.</td>
</tr>
</tbody>
</table>
Section 17: Troubleshooting

General Logon Errors
There are four possible error messages you may receive when attempting to log on to your email system.

1. **Invalid user name or ID:** This error generally appears only for IMAP, Outlook, and GroupWise. Check that you have entered the correct user name, including case and spelling.

2. **Invalid password:** As above, generally this will occur only with IMAP, Outlook or GroupWise. Check the spelling, punctuation, and case.

3. **Invalid database or directory:** This error can occur for systems where it is necessary to identify a directory where email files may be found. This would include Netscape, Eudora, cc:Mail archives, EML, and Web. It can also occur for systems where you have to identify a specific database file, such as a Lotus Notes .nsf file. For Notes, the file must exist in a readable directory. For the other systems mentioned, assuming that the directory itself exists, the program is checking for the presence of specific files. For example, the Netscape directory must have at least one .snm or .msf file. The Eudora directory must have a .mbx file, and the Pegasus directory must have a .pmm file.

4. **Unable to connect with mail system:** This is a generic error that can indicate a variety of problems. Close Transend Migrator and verify the connection with your email client. Use those same settings when migrating email data with Transend Migrator.

Usually more information is available about a logon problem in the log file. If the error message in the log file is not helpful, please send a copy to our technical support for further analysis.

Antivirus and Spam Filters
If you have viruses in your email then your antivirus or spam filter might intercept those viruses during migration. Therefore, it is best to clean your email before or after performing a migration. If the message is intercepted during migration it could interfere with a successful migration.

If you have antivirus and spam prevention software running on your source or target server, and even the workstation performing the migration, you will slow down the amount of time it takes to migrate your data. To improve performance and to decrease the amount of time it takes to migrate your data turn off antivirus or spam filtering software. Any software designed to intercept email traffic will impede performance.

Application Violations
These errors can be difficult to troubleshoot but are mostly related to corrupted email messages, or files that are not email messages but you tried to convert them. If the latter is the case then remove the offending file.

1. If an application violation (AV) happens then make note of the folder the problem happened in.

2. Enable the /LSUB switch option for logging. The /LSUB switch option will log each message subject converted (or attempted) into the log file.

3. Attempt an isolated conversion of that specific folder. When the AV happens close Transend Migrator.

4. Open the Log File with Notepad or alternate text editor.

5. Make note of the last message converted. This will tell you where to look for the problem.
6. Open the source message account and search for the message subject causing the AV.
7. Move that message into a TEMP or SAVE message folder.
8. Optionally, move the next message into the same TEMP or SAVE folder. Quite often, it was not the last message converted that caused the AV. It could be the next one in line. Therefore, this is why you need to move the next one into the TEMP or SAVE message folder.
9. Begin another migration, but this time skip the TEMP or SAVE message folder. When the migration is successful you can continue on. You will have successfully identified the corrupted or problem messages.

Microsoft Outlook
Microsoft Outlook must be the default email system for Windows when migrating Outlook email data. At least one profile must be created so that Outlook will set itself up for your email environment. Once this is done then no other profiles are needed if using the special syntax to access accounts directly.

You do not need a profile to migrate multiple Exchange accounts. Profiles are not required. But, your Windows account must have permissions to access the account you are accessing. Contact your Network Administrator to gain access to other people’s email accounts. If you are performing migrations for selected Exchange users then you must be granted RECEIVING-AS permissions on the mailbox to be migrated.

When you are using the Transend Migrator graphical User Interface you can migrate other people’s email accounts as long as you have created a profile for that user, and have the login ID and password for that user. This is not the recommended method. The recommended method is to be granted access permissions so that a password is not needed and so that a profile is not needed.

If you are migrating multiple users and/or will be using the Batch Mode Processor then give your Windows account (the account or group doing the migration) the RECEIVING-AS permissions on the Mailbox Database for your Exchange Server.
Section 18: Technical Support

Technical support is available to help you understand how to use Transend Migrator with your migration project. Please review the Help File and online resources before contacting technical support.

You are encouraged to submit questions through email. This will allow us time to properly research your situation and make appropriate recommendations.

*Note:* Transend’s normal business hours are **M-F, 9am – 5pm (Pacific).** If you will be performing a migration during non-business hours, and anticipate a need for support during non-business hours, please contact us at least 7 days in advance so we can schedule a support engineer to be available, if possible.

Sending Log Files to Transend Technical Support

It is important to include a copy of your log files when submitting a support request. You may send the log files individually, or send the log files using the *Email Log Files* menu feature from the Transend Migrator interface using the following procedures:

Select **Help > Email Log Files** from the menu list. Transend Migrator will attempt to open your default email program and then create a new message similar to the example, below.

**Notice**

The path to the log file package (a zip file containing your log files, report, and settings file) will be inserted into the body of the email message. In the example, the log file path and filename is at C:\Users\john.hieb\Documents\Transend_Logfiles.zip. Your path will be similar. Using your email program, insert the log file package. Use the path and filename listed in your email message.

Before contacting technical support, we recommend that you are using the current patches or service packs for your hardware, your operating system and software. Also, download the latest version of Transend Migrator from [www.transend.com](http://www.transend.com). Review the What’s New section of the Transend web site to review the latest release information.

Email: tech.support@transend.com
Phone: (650) 324-5370